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Introduction

InScribe is a HIPAA-compliant typing application designed by transcriptionists for transcriptionists. It is a single, integrated
application designed for heads-down production. With InScribe, everything is easily accessible — demographics, referring
physician information, AutoText (word expander), spell check — all the tools needed to easily and quickly complete a high
quality document.

Over the years, InScribe has grown and developed into a tool that helps its users consistently produce a higher number of
lines than they would with traditional word processing applications. With InScribe, far less time will be spent researching
or printing transcriptions, cover letters, and envelopes. All together, InScribe’s features allow users to be in production
mode the majority of the time, increasing their productivity and efficiency.

Additional new features and functionality introduced in InScribe 7 will be added to this user
guide in the coming months. Please check back for an updated version soon.

Highlights of InScribe include:

Demographics

Demographic information (patient name, MRN, etc.) in many cases is imported using an interface with the hospital. When
you input the unique patient MRN or name, the system automatically searches for and presents you with matches. When
the patient is selected, the system displays the corresponding appointment dates and imports all available demographics.

Referring Clinician Information

Primary care physicians, attending physicians, and other individuals can be designated to receive copies of a transcription
electronically, via auto-fax, or by standard mail. You have access to an online database of referring clinicians to easily
assign recipients per the dictation. Less time is wasted researching names and addresses.

Body of Document

The body of an InScribe document is built from templates (dictation or document), AutoText (word expander), and free-
hand typing. Document templates automatically load into the body of the transcription based on a combination of author,
document type, and location. Dictation templates are retrieved from the server based on what an author dictates (e.g.,
“normal left wrist”). No time is wasted finding the proper template.

Authorizations
When transcriptions require approval by more than one clinician, InScribe’s online database of dictating clinicians makes it
easy for you to select the appropriate clinician and assign the order of authorization.

A Nofte on Hot Keys
The hotkeys displayed in red in this user guide are the default hotkeys

assigned when InScribe is first installed. They are known as the Options
“Modified Shortcuts.” There are two other configurations available called =T
“Classic Shortcuts” and “ASR Enhanced Shortcuts.” || Disable shortcuts for re-pool and invalidate

Shortcuts: |Use Modified Shortcuts

Use Maodified Shortcuts
Use Classic Shortcuts

Use ASR-Enhanced Shortcuts |

SOLUTIONS © 2021 DeliverHealth SOLUTIONS, Inc. All rights reserved.
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Requirements

For eScription One InScribe software to work properly within a Windows environment, your system must meet the
following software and hardware requirements:

(Macintosh computers are NOT supported by eScription One.)

Minimum Requirements:
— Operating System: Windows 10

Note: For Windows 98, 2000, NT4, XP, Vista, and Windows 7 and 8.1 users - eScription One does not support any
versions of Windows prior to Windows 10. Please upgrade Windows before calling.

— RAM: 4 GB

— Processor: 1 GHz or faster (32- or 64-bit Architecture)

— Hard Drive Free Space: 1 GB

— .NET Framework: 4.7.2 or higher

— Sound Card with Speakers (or Stereo Headphones)

— Web Browser: Windows Internet Explorer 11, Chrome

— Monitor Resolution: A monitor capable of displaying a resolution of 1366 x 768 pixels
— Internet Connection: High Speed Cable or DSL

— Internet Bandwidth: 3 Mbps download; 1 Mbps upload or greater

— Communicates over port 443 to https://transcription.escription-one.com using TLS 1.2

Recommended Requirements:
— Operating System: Windows 10

— RAM: 8 GB or more

— Processor: 1 GHz or faster (32- or 64-bit Architecture)

— Hard Drive Free Space: 2 GB or more

— .NET Framework: 4.7.2 or higher

— Sound Card with Speakers (or Stereo Headphones)

— Web Browser: Windows Internet Explorer 11

— Monitor Resolution: A monitor capable of displaying a resolution of 1366 x 768 pixels or higher
— Internet Connection: High Speed Cable or DSL

— Internet Bandwidth: 3 Mbps download; 1 Mbps upload or greater

— Communicates over port 443 to https://transcription.escription-one.com using TLS 1.2

SOLUTIONS © 2021 DeliverHealth SOLUTIONS, Inc. All rights reserved.
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Installing InScribe

Note: Users working on a domain network may need administrator privileges to install eScription One or any other
programs.

Download the InScribe application from the eScription One Software page here: https://www.escription-
one.com/Software/InScribe. Click the Install Link for the version of InScribe you would like to install.

Note: Contact the transcription company manager to verify which version to install.

— Select “Open” or “Run”.
— Select “Next” on the “Welcome to InScribe 7 Setup Wizard” screen.

— Check the “I accept the terms of the license agreement” box on the End-User License agreement screen and then click
“Next.”

— Click “Next” on the “Installation Scope” screen.

— Select an installation folder. eScription One recommends using the default location. Click “Next” to advance to the next
window.

— Click “Install” to begin the installation process on the “Ready to Install” screen.

— The installation is now complete. On the “Completed Setup” screen, you have the options of “Launch InScribe Now,”
“View Release Notes,” or “View Training Materials.” Select any option(s) if desired and then click “Finish.” The “View
Release Notes” provides a summary of changes in prior versions and recently added bug fixes, features, or
improvements.

Using InScribe

Note: Obtain a username and password from the transcription company's system administrator prior to logging into

N
o]

InScribe.

Click the shortcut created on your desktop to start the InScribe program.

InScribe 7

An additional shortcut is located on the “Start” Menu. To access it, click
the “Windows” icon, then scroll to the “InScribe 7” folder. Expand the
folder and click “InScribe 7.

InScribe 7

InScribe 7

Bl

Intel

&

Intel PROSet Wireless

Intel® Graphics Command Center

G

L fiype here to search

SsQLUTIG NS © 2021 DeliverHealth SOLUTIONS, Inc. All rights reserved.
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Select a Region

The first user who logs in to a new InScribe installation
will be prompted to select a region. The Select a
Region dialog does not appear when upgrading
InScribe and logging in for the first time, nor does it
appear if you do a basic uninstall and reinstall
InScribe.

Selecting the correct region ensures you are
connected to the correct server.

eScription One

March 2021

" Select Region X
Please select your region below

Region | United States (US) o
United States (US)
Australia (AUS)

Canada (CA)
Europe (UK)

Note: This region can be changed at any given time on the login screen if needed. However, the need to change an
application region is very rare and should only be done when instructed to do so. If you do not see the region you need in

any application, please contact Support.

Login Window

After selecting a region (if applicable), the “eScription One InScribe” login
window opens. The following options appear at the bottom of the window: - o X

— Download Dictations on sign in: Enable this option to download

dictations automatically on login.

— Sign in with Training Mode: Log into Training Mode to access the Inscn be

training files.

Note: To see the ‘Sign in with Training Mode’ option, you must select
‘View Training Materials’ during installation and download the InScribe
training files, or you can download them from the software site:

https://www.escription-one.com/Software/InScribe.

— Change Region: Change the region associated with the user’s

location. See also Select a Region.

Nuance®

eScription One

[ ] Download Dictations on sign in
[] sign in with Training Mode

Version: 7.2.19297.36657 - United States (US) B
Change Region [Tl_ogm]

© 2021 DeliverHealth SOLUTIONS, Inc. All rights reserved.
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Initial Login
To log in for the first time, click the New Login button at the bottom of the |- - o  x
login window.

Username

The credentials screen opens.

Password

Enter your Username, Password, and Company, then click Log In.
Company

— Username: Login credential to identify a transcriptionist.
— Password: Authenticating word or passphrase for secure login.

— Company: Abbreviation or Acronym identifying the transcription
company.

The Forgot Password? link allows users who have saved a valid email
address to receive password reset instructions by email if itis lost or

forgotten. For more information, go to Email Verification and Resetting [ ol |
your Password.

Note: If multi-factor authentication (MFA) has been enabled for your company, please see ‘Setting Up Multi-Factor
Authentication’.

Logging in after the First Time EE——

®
The next time you log in, your saved login credentials appear Nuance

on the login screen, along with the date and time of your last escri ption 0 ne

login. Your saved credentials include your Username and

Company name. InScribe does not save passwords. I n S C ri be

MTdemo/DEMO
‘ Last Login: 11/11/2019 3:19 PM Q

Click the saved credentials icon.

[] Download Dictations on sign in

[] Sign in with Training Mode

Version: 7.2.19297.36657 - United States (US)
Change Region

New Login

SsQLUTIG NS © 2021 DeliverHealth SOLUTIONS, Inc. All rights reserved.
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The login screen opens, with the credentials filled in. Just enter

- O X

your password and click Log In.
N.ote: The pre-filled fields are read-only.l To log in with a Username Vs
different Username and/or Company, click Cancel to return to
the login screen and choose New Login. Password
InScribe saves each set of credentials you use to log in. The

. . Company DEMO
most recent login appears at the top of the list.
If you want to remove a saved login from the screen, for Fonet P

example, if you are a manager or if you perform

QA, and you will not need to log into this account
again, click the stop sign icon. The credentials will s
be removed from the screen.

Cancel

© 2021 DeliverHealth SOLUTIONS, Inc. All rights reserved.
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Setting Up Multi-Factor Authentication Using Auth0 Guardian

Multi-factor authentication is another way to verify a user’s identity, adding an extra level of security to the current login
process. If your company has enabled multi-factor authentication, there will be a one-time procedure that requires you to
download an authentication application called AuthO Guardian onto your cell phone and create an account. Subsequently,
when logging in, you will only need to accept a notification sent to your phone. This one-time procedure does not need to
be repeated for each transcription app. If you have set it up for InScribe, you do not need to set it up again for
InCommand.

When logging in for the first time after multi-factor

authentication has been enabled, you will enter your login
credentials as usual. Before the application opens, the ‘Secure ~
Your Account’ screen appears. Here you begin the one-time

multi-factor authentication setup.
[a

<

Step 1: Download the Auth0 Guardian app

AuthO Guardian is a free security app for performing multi- Secure Your Account
factor authentication. With the Guardian app, a notification is

. In order to continue, install the AuthO Guardian app
sent directly to your cell phone. There are no codes to via the app siore from your mabile device.

manually enter; just press ‘Allow’ to accept the notification.

If you do not have the AuthO Guardian app already installed on L ”
your phone, you must first download it from the Apple store (for App Store Google Play
iPhone) or Google Play (for Android). Choose the appropriate

button to view the location of the app’s download site. Search
‘AuthO Guardian’ and download it to your phone.

AuthO Guardian =)
Multi Factor Authenticator
AuthO

Try another method
R — v

Cancel

Free

Once you have the authentication app downloaded, open it. In your InScribe app, click Continue on the ‘Secure Your
Account’ screen.

Note: Other authentication apps may work as well but are not officially supported.

© 2021 DeliverHealth SOLUTIONS, Inc. All rights reserved.
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Step 2: Scan the Activation (QR) code
Next, use the authentication app to scan the activation code that appears in InScribe by holding your phone up to the
code. This will link the authentication app to your InScribe application.

< App Store ! T 11:35 AM 100% =

* .
~
%
Secure Your Account
Scan the QR Code below using the AuthO
Guardian app on your mobile device.
Try another method
v
Scan a QR code to enroll your device.

If the scanner does not automatically open, you may need to click the plus button at the top of the Guardian screen to add
a new account.

< App Store ! T 11:37 AM 100% =

*x i

<& eScriptionOne

© 2021 DeliverHealth SOLUTIONS, Inc. All rights reserved.
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Step 3: Copy the Recovery Code

After scanning the QR code, you will receive a recovery code (in
InScribe). If you need to log in and do not have your device, you
can paste or enter this code to access InScribe. Copy the code
and keep it somewhere safe.

Click the check box indicating that you have recorded the code,
then click Continue.

You now have an account to which a notification request will be
sent each time you log in. The email on your account will be the
email listed for you on the Transcription Information or User
Information screen in InCommand.

InScribe will now open.

Note: Remember to have your phone nearby when you log in
from now on. See the next section for details.

< App Store wi!!| T 11:37 AM 100% =

* 5

<& eScription One

eScription One

March 2021

N

Almost There!
Copy this recovery code and keep it somewhere

safe. You'll need it if you ever need to log in without
your device.

STEFP59MSXOF6JBD1XODFHLW

Copy code

| have safely recorded this number

Cancel

< App Store ! T 11:37 AM

< x

<& eScription One

022176

© 2021 DeliverHealth SOLUTIONS, Inc. All rights reserved.
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Logging in with Multi-Factor Authentication

Once you have completed the initial MFA setup process above, you will subsequently log in to InScribe as shown in the
steps below.

1. Open the Guardian app.
2. In InScribe, enter your login credentials.

The Verify Your Identity screen opens, indicating that a notification has been sent to your phone and is awaiting
confirmation.

3. Inthe Guardian app, click Allow.

O % «!! Verizon
~
AUTHENTICATION REQUEST
fa . ..
%’ -8 eScription One
Verify Your Identity
We've sent a notification to the following device via IE (11.(
the AuthO Guardian app: Windows
g iPhone
C Awaiting confirmation Resend T, United States
OR
Manually Enter Code May 14, 2020 at 5:50:36 PM
Tr)" another method
(V)

After successful authentication, you will automatically be logged into InScribe.

If you do not receive the natification, you can choose to have the notification resent, or you can manually enter the code at
the bottom of the Guardian app (see below).

© 2021 DeliverHealth SOLUTIONS, Inc. All rights reserved.



1 4 eScription One March 2021
If you do not receive a notification, you can choose Manually Enter - o x
Code. R

n

g

Verify Your Identity

We've sent a nofification to the following device via
the Auth0 Guardian app:

g iPhone
C Awaiting confirmation Resend

OR

Manually Enter Code

Try another method

v
Enter the code appearing at the bottom of the Guardian app.
ance
wll Verizon ’ - | X
<
~

<8 eScription One

n

o

Verify Your Identity
lE_' 1.0), ) Check your preferred one-time password
Windows (8 application for a code.

‘ £ 802169 ‘

nformation about your last login:

, United States

May 14, 2020 at 5:57:37 PM

Try another method

802 169 ’

Click Continue. After successful authentication, you will automatically be logged into InScribe.

Note: If for some reason you cannot log in with MFA after having done so previously, please contact your manager to
have it reset.

SOLUTIONS © 2021 DeliverHealth SOLUTIONS, Inc. All rights reserved.
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Email Verification

If you do not have an email address on file, InScribe will prompt you to enter one when you log in. After doing so, a
notification appears, indicating that a confirmation email has been sent to the email address entered. (You can choose not
to enter an email, but will be prompted again on your next login.)

< B O &

Welcome to the Nuance platform. Please verify the email
address on your account by using the link below. This
email address will only be used for forgot password
requests.

Verify Email Address

This link will expire in 2 hours. If you did not request this
confirmation, please contact support at 800-858-0080
or mailto:esone@nuance.com.

Click on the link in the confirmation email to complete the verification process.

To edit the user email address, go to File menu> Options> General> Account Options> Modify Account. If the email
address has previously been verified and is then edited, you will be prompted to verify the updated email address.

Resetting your Password

If you have forgotten your password, you can reset it using the steps below. -]

1. Onthe login screen, enter your Username and Company, then click Forgot
Password?.

Username

Password

Company

2. On the ‘Forgot Password’ screen, click either the Send Email button or ‘Have
reset code?’ link (if you already have a reset code).

- 0 X

Forgot Password

Username Tl |
Company
DeliverHealth

© 2021 DeliverHealth SOLUTIONS, Inc. All rights reserved.
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3. If you choose Send Email, you must have a verified email address (see above). If so, an email will be sent to you
with instructions and a link for resetting your password. Once you click the link, the ‘Reset Password’ screen appears
with the reset code filled in. Enter the remaining information, then click the Reset Password button.

Reset Password

Provide your new password below

Username
Client
Reset Code

New Password

Verify Password

Reset Password

If you choose ‘Have reset code?, the ‘Reset Password’ screen appears without
the reset code filled in. Enter the code and remaining information, then click the

Reset Password button. Reset Password
If you selected ‘Send Email’, you can also copy and paste the code from the Provide your new password below
email and paste it here. et

Client
Reset Code
New Password

Verify Password

SsQLUTIG NS © 2021 DeliverHealth SOLUTIONS, Inc. All rights reserved.
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Main InScribe Screen

Once you successfully log in, the initial InScribe screen opens:

| B 3 |nScribe - AA — O X
—
Home Transcription Data Format View @ -
0:00/0:07
F1 F2, (F3 (k4 F5 Fé F7 F8 Fa F10 Fil F12 /
W) (44) () (u) () (2)100% ~
JumpTo  Play Rewind Fast Add Copy Complete Mark for Save Auto Show Download R
Next Field Forward Associate Dictation Review Text Pool Next Uy g 2 4)100% ~ .1
28660 &3 ! TID Queued Client Doc Type Clinician Dict Date Length Due Date Status
Patient ID 5271066 8 ]209149130 [4:36 PM ESODemo | Follow Up Vi 2/19/2020 2/21/2020 6]
8 209608179 4:36 PM ESODemo ASR Progress Ris C. Kodak 2/16/2014 1:19 2/26/2020 6: In Transcription
Patient Name | CAROLINE DOTY ! Ny -
8 210717646 436 PM ESODemo Follow Up Vi: Demonstratic 3/20/2020 0:21 3/21/2020 17 In Transcription
Gender F 1 208486352  4:36 PM Demo Discharge Su Test Doc, MC 2/6/2020 0:06 2/7/2020 3:1. In Transcription

59
S(vEE T 100% - _

Birthdate | 11/14/1987
Appt | 172572020 'S YV == . IU|s v 5, R @lEE=
Appt Time 12:00 PM Elﬂ 5] J =

Dict Date | 2/19/2020 PRIMARY PHYSICIAN: [as dictated]
Order # ORDERING PHYSICIAN: [as dictated]

Clinician | User, Demonstrati ~

]
il
1]

i r

STRESS INTERPRETING PHYSICIAN: [as dictated]

Doc Type | Follow Up Visit v '
NUCLEAR INTERPRETING PHYSICIAN: [as dictated]

Location | Fast v
Pat Letter i INDICATION FOR STITNV/CTINTCAT. HISTORYV: [ac dictatad] e
e Hp 4
il Ceete @ @ B & P Addl Auth &) Comment Tags &) Comment 8
UF2  HISTORY AND PHYSIC/
“ v
UF3
1EA W14

12 items in your pool 10 new feedback items Your email address is not verified. TRAN: AA(12839)

Download Dictations

Downloading Dictations: At login, a request for dictations is made to the eScription One Server. This option can be
disabled by unchecking the option “Get Dictations on Login” on the login screen or in File > Options > General > Startup
Options. If this option is disabled, press “Next” (Hotkey: F12) to start downloading jobs. A status bar tracks the download
process in the bottom left hand corner. Once the first file has been completely downloaded, transcription work can be
started, with future downloads occurring in the background.

Downloaded dictations appear at the top of the screen. By default, the maximum number of dictations is three.

[ 1 000/ 7:23
Fl, (F2 F3,  Fa4 F> Fo Fi F8 F9 F10 F11 |[F12 :I /
; M) (44) (¥) (1) (») (%) Normal -
Next Play Rewind Fast Add Copy Complete Mark for Save AutoText Show | Next N .
Field Forward Associate Transcription Review Pool s G #)100% ~ A
2 8 @G & L_§ ! TID Client Document T Author Location Date Dictate Length Due Date Status
Patient ID 1] 2673886 ] Emdat ETRAI[Chart Note _John Orienta]Chicago | | | |
atient ID:
9000006 2 3673887 Emdat ETRAI Chart Note John Orienta Chicago In Transcripti
. 3 3673888 Emdat ETRAI Chart Note  John Crienta Chicago In Transcripti
Patient Name: Gender:
Cory Jones M

© 2021 DeliverHealth SOLUTIONS, Inc. All rights reserved.
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Function Keys

Function Key: Downloading a transcription will enable the Function keys located at the top of InScribe. You can
customize the function key actions if necessary (File > Options> Shortcut Keys).

The options below are the defaults and are the most commonly used functions.

Fl F2 F Fa Fa Fo F7 F8 S kD E\ El2
Mext  Play Rewind Fast Add Copy Complete Mark for Sawve AutoText Show  Mext
Field Forward Associate Transcription Review Pocl

< F1 > Next Field: Skip to the Next [Field] within the transcription.
< F2 > Play: Play and Pause the dictation playback.

< F3 > Rewind: Rewinds the dictation playback.

< F4 > Fast Forward: Fast Forward the dictation playback.

< F5> Add Associate: Add a carbon copy recipient.

< F6 > Copy Transcription: Copy the Dictation Audio, Info Pane Demographics, Carbon Copies, Additional
Authenticators, and the Transcription text of the selected Dictation to a new Transcription.

< F7 > Complete: Mark the selected transcription as “Done” or “Completed”.

< F8 > Mark for Review: Mark the selected transcription as "Marked for Review."
< F9 > Save: Save the selected transcription.

< F10 > AutoText: Create macros and text expansions.

< F11 > Show Pool: Display work currently available for transcription.

< F12 > Download Next: Advance to the next dictation, download new files if available, and upload completed work.

SsQLUTIG NS © 2021 DeliverHealth SOLUTIONS, Inc. All rights reserved.
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Info Pane

aaG@DeB
Patient ID:
Q000006
Patient Name: Gendern

Cory Jlones U]

Date of Birth: | 5/21/1954
Date of Encounter. | 10/16/2014

Encounter: sl £

Date Dictated: | Select a date

Order Number:

Author: |Orientation16 M.D., . ~|

Document Type: [TmCharl v]

Location: [Chicagu V]

User Field 1:

User Field 2:
User Field 3:
User Field 4:

User Field 5:

Info Pane Functions

March 2021

Demographic Information: Patient demographic information is located on the left
side of the InScribe screen. Depending on the dictation device used by the author,
demographic information may auto-populate when downloading the audio file.
When demographic information is not automatically available, search for a patient
using the Patient ID and Patient Name fields. To search by Patient ID, enter the
exact number and press “Tab”. To search by patient name, enter the entire name or
any part of the patient's name and press “Tab”.

If appointment information isn’t available, information can be entered manually.

If the patient has multiple appointments, the “Appointment Listing” window will
appear. Choose the appropriate appointment for the dictation, based on the
dictating physician and the date. Use the arrow keys and press “Enter” to select the
appointment.

(E=8 I
Date of Encounte  Time of Encounte  Description Patient Name ~ Gender Date of Birth Patient ID

____

10!'15;’2002 12:00 AM Steven Palmisano Corey Jones M
10713/2002 12:00 AM

,ﬁl Appointment Listing

John Demo Corey Jones M 9000006

— Patient Name Search: If the Patient ID dictated does not match the name
dictated, find the patient with a Name Search. To look up a patient name,

&s@_‘l/&[é

press the “Patient Name Search” icon. (Hotkey: Ctrl+F) Patient ID:

. . _ 9000006
The “Patient Search” window opens. Search by Last Name, First Name, and Patient Name: Cordien
Date of Birth. The search function can also search for partial names. For Coty Jones M

example, searching for “and” in the last name field will return results for
“Anderson” and “Sanderson”.

“.7 Patient Search — O W
Last Name ‘ | ‘ Age Search
First Name Gender

|

Birthdate ‘Selec’[ a date

— Patient ID Search: Search the patient database by ID for available Appointments. (Hotkey: Ctrl+N)

— Appointment Search: Search the patient database for available appointments based on the Patient ID in the
demographics.
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— Clinician Appointment Listing: Search for all appointments by Clinician and Appointment Date based on the
Appointment Date and Clinician selected in the demographics. (Hotkey: Ctrl+Shift+L)

— Edit Patient: Edit patient Demographic and Contact information. (Hotkey: Ctrl+Alt+E)

— List Document Types by Description: Toggle between the short name and the long description in the Document

Type drop-down list. (Hotkey: Ctrl+Alt+X)

Print and Document Template Demographics

Choosing the correct Clinician, Document Type, and Location are critical to generating a properly formatted document.
These three demographics determine which template is loaded. The print template, which includes any headers, footers,
and letterhead, will automatically update when a new combination of Clinician, Document Type, and Location is selected.
The finished document is built by combining the print template with the document template and transcribed text.

If the clinician, document type, and/or location change after the document template has been loaded, InScribe users will
need to decide what to do with the existing transcription in the main editing window. If the new combination has no
document template associated with it, the existing transcription will remain.

— Overwrite Transcription: Delete all existing document
template and any existing transcription. Any existing text will
be replaced by the new Document template.

— Insert at Cursor: Insert the new document template at the
location of the cursor.

— Keep Text: Keep the existing transcription without loading the
new Document Template.

Clinician

Select from a list of possible dictators. The clinician field typically is populated
with the dictators when a file is loaded into InScribe, but can be changed.

(Hotkey: Alt+R)

Document Types

Choose from a list of possible document types available for the author. The
author selects a document type during the dictation process. If an author

a7 New Document Template

Your selection requires a different document template,

and the transcription is not empty.

Overwrite transcription
Replace the entire transcription with the document template.

Insert at cursor
Insert the document template at the current cursor position.

Keep Text

Leave existing transcription text and continue editing.

— O X

I Clinician: | Orientation MD, lohn » J

Doc Type: [TmChart

¥ ‘

selects the wrong document type or does not choose one, a new document Encounter.

type can be selected from the list. The list of available document types will
change based on the author. Once a document type is selected, a Document

Location: IChicago v]
Date of Encounter | Select a date |
Date Dictated: | Select a date |

Template will automatically load into the body of the transcription based on the Crder Number:

combination of Author, Document Type, and Location. (Hotkey: Alt+W)

Author: | Orientation16 M.D., . |

Document Type: |TmIChart

’)
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Location
The location demographic can be used to specify a specific physical location - = =
(South Clinic) or a department or organizational division (Cardiology Clinician: IOnentatlon MD, John 'l
Department). Most dictation methods allow or require the clinician to select a
location. (Hotkey: Alt+L) Doc Type: leCha’t 'l
| Location:l Chicago

Pat Letter:

U-Field 1: | Madison
Warrenville

11-Fiald 2-

Carbon Copies

— Add CC: When an author needs to send a copy of the transcription to another person, B s | tpir ous ot vew

the recipients are called Associates and are added in the CCs panel. To search foran > 2 8 &= & & @ &1
<X, Field Forward | Associate [Transcription Review
associate, press “Add Associate” at the top of the screen or click the green <. . P ML —
5 . :
(Hotkey: F5 or Ctrl+Alt+N) e e
Patient Name: Gender: 3 3673888 Emdat ETRAI Char
To initiate a search, some or all of either the Associate’s first or last name must be et ] © 5w
entered. Additional information in the form of specialty, City, State, and Zip Code is ottt | g
optional. If you have a BenchMark KB subscription, you will also be able to search the Ot s cne ()| SUBECTNE
national physician’s database. Click for more information: °"‘"“:::f dictated]
http://www.interfix.biz/kbemdat.aspx oocment g [fmean = g
Lot i ] ASSESSMENT:
Press enter, the Search button, or use Alt+S to perform the search. T;";::‘::] i
PLAN:
. i . . User Field 2: o
Double-click a name from the results to open the Associate Details window. e Fed
Us:rrfddk C& o &’ )
User Field 5: —
o Primary Associate: One Primary associate is allowed per Transcription. W Ssceckis Dupets B 5|
This is the associate the document will be primarily addressed to. Itis Cory 0: [Test1 ] NIRRT (S|
. . . . First Name: [Test Mi. Last Name: One |
possible to have a document without a primary associate. et [iva Sttt [t :
. i Greeting: Greeting Punctuate: V]
o Add Associate: Add the new Associate to the database or update an Company Name: Test Associate Business Name Only :
existing associate’s information. This option must be enabled by the Specialty: |Specialty ‘
Transcription Company. Adkges 1: 1234 Mol
Address 2: Add2
) . ) Address 3: Add3
o AutoFax: AutoFax status can only be changed if the Add Associate box is Giy:[Ciy
checked. When AutoFax is active, the associate will receive a fax via the State: ST
eScription One AutoFax feature. A valid 10-digit fax number must also be Z“’?"?‘ 1234\5
present' Phone: Phone Fax: Fax
. . . . Location: v
o PCP for Patient: Add an associate as the Primary Care Provider. The Associate Type: | Primary Associate
Primary Care Provider is automatically copied on any future transcriptions 0 :“;:’oﬁ‘:f"“‘“
for the same patient. ] [ PP for Patient
Name, Greeting. Company Name or Address are required to save an associat
V| Auto-Search on New Copy
Associate Loaded. [ ok | [ cancel |
DeliverHealth
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— Delete CC: Remove the selected associate from the CC list. (Hotkey: Ctrl+D)

— Edit CC: Open the Associate Details window for the selected associate. @ @ B2 & P Addl
(Hotkey: Ctrl+E)

— Insert To Whom It May Concern Associate: Insert a generic “To Whom It May
Concern” as the addressee.

— Make the Selected Associate the Primary Associate: Promote the selected associate to the status of the Primary
Associate. (Hotkey Ctrl+1)

— Create Associate from Patient: Convert the Patient’s information into an associate entry. (Hotkey Ctrl+2)

Additional Authenticators

Additional Authenticators are added when a document requires more than one physician’s signature on the document.
This frequently occurs when resident physicians are being overseen by attending physicians, but additional authenticators
are added in a variety of situations. The drop-down list contains all the available dictating users for the Client.

— To add an additional authenticator, open the drop-down menu, then select a provider's name. (Hotkey Ctrl+Alt+A)
You can also use the shortcut to put the focus in the drop-down menu, then scroll with the arrow keys and press enter
(or use the shortcut again) to select.

— To remove an additional authenticator, select the provider's name from the list and press the button. (Hotkey
Ctrl+Alt+D)

— Usethe “ and  buttons to change the order in which the authenticators sign the document and the order in which the
signatures appear on the transcription.

Comments and Comment Tags

Comments and Comment Tags are used to communicate information that does not appear on the document itself.
Comment Tags are canned responses to frequently occurring issues. Healthcare providers researching documents can
search and sort by comment tags in the InQuiry application. Comments are used to communicate with either QA
personnel or with the healthcare providers. The transcription manager will have specific instructions on how to use the
Comment and Comment tag features.

— To add a comment tag, open the drop-down and select a comment from the list, or arrow down and press enter.

— To remove a comment tag, select an existing comment tag and press the - button. (Hotkey: Alt+])

— To add comments, enter text in the available space. The comments box supports cut, copy, and paste shortcuts.
(Hotkey: Alt+ )

— Press the button to erase all comment content.

— Press the #% button to display available discrete data.

Discrete Data

Some document templates define fields that are specifically named by your transcription —
company. This allows the text used to replace that field to be referenced by a field later in | <™

the document or by an interface. The Discrete Data window allows you to see what fields
have been identified and named, and what values have been associated with each field.

Please note that this feature is rarely used.
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File Tab prm—

The File menu contains Options and Administrative options.

Home Transcriptio

— Save: Saves the contents of the Active Transcription. This performs the same function as \y Save
E i :
the = button in the top left corner. (Hotkey: Ctrl+S) O o Bomad
— Stop Downloads: Stops the automatic download of new dictations. The status of downloads | . ‘
is available in the top left corner. (Hotkey: Ctrl+Alt+2) =y Preview Transcription
o ™ Indicates dictations have not been blocked from downloading. @Z) Explore
o “ Indicates dictations have been blocked from downloading. | Backup Personal Files

— Preview Transcription: View the document as it would appear in InQuiry.

wiss. Restore Personal Files

o *” Show/Hide Labels under the function buttons.

{C Options
-
o === Generates a Print Preview as if the document was printed. QS
‘ Exit
o L_fe=n | Refreshes the window to display any changes made. Alterations can be made in
InScribe while the preview window is open.
. . =% Preview Transcription B - - [m] X
o %= | Closes the Transcription Viewer. | e e
LN
Consultation a
Patient Name: CRYSTAL RILEY Date of Service: January 9, 2020
— Explore: Explore the contents of the folders where the raw Vel e ation User Date of Birth: - March 20,1950

dictation and transcription files are stored. The contents of this

. . . . OUTPATIENT CONSULTATION REPORT
folder are primarily viewed when troubleshooting.

:Chief Complaint: [] [leave blank if not dictated - DO NOT REMOVE HEADING]
— Backup Personal Files: Create a backup of AutoText entries | biagnosis: [
and words that have been added to the personal dictionary. The |HisTorY oF PRESENT ILLNESS:
backup is placed in the InScribe folder of the computer’s i
Documents.

Review of Systems: Pain: [. Weight loss: [I. [If pain and weight loss not dictated, please leavev

— Restore Personal Files: Restore AutoText and Personal
dictionary entries from the backup location.

— Options: Customize InScribe behaviors and settings. (See Options for additional information.)

— Exit: Exit and log out from the InScribe application.
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The Home tab contains the customizable function keys (see Function Keys) and the dictation playback controls.

ﬁ Home Transcription Data Format View

0:00/1:03

Fl F2 F F4 F5 Fo F7 F8 F9 F1I0 F11 Fi2
M) () (k) (i) ok (2)125% -
Mext  Play Rewind Fast Add Copy Complete Markfor Save AutoText Show  Next o
Field Forward Associate Dictation Review Pool g W o W #)100% ~ 4
Dictation Playback
The controls for dictation playback are located to the right of the F12 key on the Home tab.
They include:
4. Restart Dictation (Hotkey: Ctrl+Shift+2) 1 2 3 4 5} 000/ 7:23
5. Rewind (Hotkey: Ctrl+Shift+C) W) T TR T i) (2) Nomal - ~
. IC:) =D #100% ~ 1
: + +
6. Play (Hotkey: Ctrl+Shift+X) 5 78 0

7. Pause (Hotkey: Ctrl+Shift+Q)

8. Fast-Forward (Hotkey: Ctrl+Shift+V)
9. Mark Index (Hotkey: Ctrl+Shift+)
10. Jump to Index (Hotkey: Ctrl+Shift+J)
11. Clear Index (Hotkey: Ctrl+Shift+K)
12. Insert Time (Hotkey: Ctrl+Alt+T)

Speed and Playback Rate
The Speed Control next to the playback controls is a drop-down menu. You can adjust the rate of
dictation three different ways:

— Click on Increase Speed to increase the speed to the next higher percentage of total speed
rate, or click Decrease Speed to decrease the speed to the next lower percentage of total
speed rate.

— Use keyboard shortcuts (Hotkey Increase: Ctrl+Shift+. ) and (Hotkey Decrease:
Ctrl+Shift+, )

— Click directly on the speed percentage.

To remember the playback rate by author, go into the File tab> Options> Playback and select this
option.

LUTIONS © 2021 DeliverHealth SOLUTIONS, Inc. All rights reserved.
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1w ) 100% "

Increase Speed

-JC)

20 00
14 11

0 0:0:

Decrease Speed|

50% - Slowest

60%

70% - Slower

75%

80% - Slow

90%

(V] 100% -
110%
125% -
140%
150% -
175%
200% -

Normal
Fast
Faster

Fastest
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Volume Control

0:00/1:19 At
The Volume Control is a drop-down menu below the speed control. In InScribe, you can adjust the W Sl125% - LM
volume three different ways: o (@ o '_" I
— Click on Louder to increase the volume to the next higher percentage of total volume, or click Softer OL_: Softer R
to decrease the volume to the next lower percentage of total volume . 19 V] o0
) ) 0:(6 0T b(
— Use the keyboard shortcuts (Hotkey Louder: Ctrl+Shift+9) and (Hotkey Softer: Ctrl+Shift+8) it PR
70%
— Click directly on the volume percentage. S
50%
Volume can also be adjusted with the Windows Volume settings. SO
30%
ShadowScribe Cursor Functions 20%
These cursor features are only available during ShadowScribe or Voice Recognition jobs that have |5
passed through the ASR engine for initial transcription.
— Attach Selection: Attach the Selection cursor to the Playback cursor. (Hotkey:
Ctrl+F12) ‘e’ Attach Selection

. . o G} Move Playback To Cursor
— Move Playback to Cursor: Adjust the playback time to match the cursor’s location in the -

Transcription. (Hotkey: Ctrl+Shift+F12) i COHCEHon

Correction Playback
Toggles between the retrieved dictation and the correction dictation when the “Retrieve & Correct” feature is used from
Get Prior Transcriptions. (Hotkey: Ctrl+Shift+R)

Skip Silences % Inscribe Options - 0 x
A feature called ‘Skip Silences’ can be used to skip silences P
detected in ShadowScribe (also known as ASR, VR, or voice - Advances options for werking with InScribe.
recognition) dictations. This feature will only work with dictations — I
that have been submitted to ASR and have a draft returned. - ] Use global funcion keys
. . . Foot Pedals Prompts
Enabllng Sklp Silences - [ Automatically check for new dictations every 1 minutes
To enable the Skip Silences feature, the audio player in InScribe ottt || o oS
needs to be changed. To do this, go to File, then Options, then [ F;‘:e“"d‘ —
. . oot pedals remain active while other applications are active
Advanced. In the Playback section, change Audio Player to o kp ”
i
Advanced.
Audio Player: | Advanced
Press OK to close the Options window. o Ploger P
InScribe Wave Player: Automatic
In the Dictation Controls section, you will now see a Skip Silences Field Behavior
button. Click to toggle the feature on (the button will be orange) or [ e atemste mestomo fornet
off. The button will appear disabled if a non-ShadowScribe job is ==
loaded
0:23/4:39 (& Attach Selection | Skap Silences | i
W (4 (») () ) (#)T0% - 53 Move Playback To Cursor
[ T #)100% ~ A\ Correction Playback
o :

When enabled, the playback rate will increase during detected silences and resume the normal rate when the silence is
over.
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Transcription Tab

The Transcription Tab contains options for Creating, Navigating, Marking, Spelling, and Completing a transcription.

Home Transcription Data Format View
* 1 Move Up O ﬁ @z / [ Repool
+ 1 Move Down 4 ‘K [. ] Invalidate
New Copy Download 3 Mark for  Lock Spell Complete

Next % Review Check ~ |;§ Upload

Create
— New: Create a Transcription or TID, without an audio file. (Hotkey: Ctrl+Shift+N)

— Copy: Create a Transcription with some or all of the properties as the Active Dictation.

o Copy Transcription: Copy the Dictation Audio, Info Pane Demographics, Carbon i Home | Transcription || Data

Copies, Additional Authenticators, and the Transcription text of the selected Dictationtoa — ) 1

new Transcription. (Hotkey: Ctrl+Shift+Y) - )
Copy Download Next

Transcription «

o Copy Dictation and Header: Copy the Dictation Audio, Info Pane Demographics,

. o . I_| CopyT ipti
Carbon Copies, and Additional Authenticators. | || Copy Transcription

[_} Copy Dictation And Header

o Copy Dictation: Copy the Dictation Audio File only. (Hotkey: Ctrl+Alt+Y) ' "? e

Split Transcription

o Split Transcription: Copy the Dictation Audio, Info Pane Demographics, and the
Transcription text after the cursor to a new Transcription. (Hotkey: Ctrl+Alt+S)

Navigate

— Download Next: Advance to the next dictation already downloaded, download the next dictation file from the server if
the maximum allowed number of downloaded jobs has not been reached (this is set by the transcription company
manager), and upload completed work. (Hotkey: F12 or Ctrl+Shift+Return)

— Move Up/Down: Move between available downloaded dictations and audio files. (Hotkey Up: Ctrl+Alt+Up) and
(Hotkey Down: Ctrl+Alt+Down)

Marking
— Mark for QA: Mark the transcription to be routed to the next QA level when available. (Hotkey: Ctrl+Q)

— Mark for Review: Mark the transcription to be routed to the Client Review folder when available. (Hotkey: Ctrl+W)
— Lock: Lock the transcription file to prevent accidental modification or completion. (Hotkey: Ctrl+Alt+K)

Spelling

— Spell Check: Manually initiate the spell check process. (Hotkey: Ctrl+K)
The Check Spelling dialog includes an added option to “Skip” misspelled words, rather than “Ignore”, which allows the
word to be checked again in subsequent spellchecks.

o Enable Spell Check as You Type: Check this box to activate real time spell checking.

Completion
— Complete: Mark the Transcription as completed and ready to upload to the server. (Hotkey: Ctrl+O)

’ DeliverHealth
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— Repool: Check the Transcription and audio file back into the server and save any changes made to Author, Document
Type, and Location. (Hotkey: Ctrl+H)

— Invalidate: Mark the Transcription as invalid. Invalid Transcriptions are removed from the standard workflow.
(Hotkey: Ctrl+J)

— Upload: Send all Transcriptions marked as complete to the server. (Hotkey: Alt+U)

Data Tab

The Data Tab has function buttons used to acquire information stored on the database for use during the transcription
process.

File Home Transcription Data Format View

ABC %B @Nexl ) % £ Clinician  -= Problem List | [ Patient j E‘
@C\ear Remaining i : &4 Associate =2 Append/Unappend
Document Dictation Patient Appointment Transcription o Commands Sections
- - - { |Auto Text .= Problem List - -
Templates S New Document Template N =

— Document: Download the Document Template for this Author,
Document Type, and Location combination. (Hotkey: Ctrl+Shift+G)

Your selection requires a different document template,
and the transcription is not empty.

Overwrite transcription
Replace the entire transcription with the document template.

Insert at cursor
Insert the document template at the current cursor position.

Keep Text

Leave existing transcription text and continue editing.

— Dictation: Retrieve a list of Dictation Templates or Normals, available to
be inserted at the cursor. A preview of the dictation template appears to
the right of the list, allowing you to view the template before selecting. Select a template to use:
(Hotkey: Ctrl+Alt+G)

== Dictation Templates — O X

2448 72-HOUR AMB. EEG | ~ | | REPORT ON

|

ACL Reconstruct [J-HOUR
Attending Attestation AMBULATORY
Fields Blockquote v | ELECTROENC ~
— Next: Jump to the next available [Field]. Fields are indicated by the I
nsert and Close| | Insert | | Close |

square brackets and may or may not contain text. (Hotkey: Ctrl+G)

— Clear Remaining: Delete any unfilled transcription [Fields]. (Hotkey: Ctrl+[ )

Search
— Patient: Open the Patient Database search window.

o By Number (Hotkey: Ctrl+N)
o By Name (Hotkey: Ctrl+F)

— Appointment: Open the Appointment search window.
o By Patient

o By Clinician (Hotkey: Ctrl+Shift+L)
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— Transcription' "3 Prior Transcriptions - m) X
Get Prior Transcriptions based on: | |Patient [_IClinician [¥Doc Type Refresh
o Prior: Search for EXIStlng transcrlptlons Transcription Id Clinician DocType  Location Appt Dict Date Available Receipt Code
H H . @ [ 208148302 Demonstration User  Chart Note  East 2/19/2020 12:00 AM  2/19/2020 3.09 AM Yes 5052760
based on Patient, Clinician, and/or
. @[] 200179821  Demonstration User ChertNote Hospital 2/11/20209:15AM  2/19/20001256PM  Yes 504659
Document Type. Click Refresh after © & oo Derontaton s Chathote 2r12020 25 4 “ozz650
i it . i 208676168 NuanceV.Jacoby  ChartNote West  2/6/2020230PM  2/6/2000245PM  Yes
selecting criteria. (Hotkey: Shift+F1) g ance V. loccky _ ChartHote Wiest 2/ AF000 245 e
@[] 210392957  Demonstration User ChartMote West — 2/3/2020 1200PM  3/12/2020 1133 AM  Yes 7241619
After Searchl ng, you Can: @, [ 206068594 Demonstration User  Chart Note  West 2/3/2020 10:00 AM 12/19/201910:52 AM  Yes 35339134
@, [0 207267563 Nuanca V. Jacoby Chart Note  West 1/26/2020 1:00 PM 1/1472020 2:19 PM Yes 1451591
1 1 1 1 1 1 @, 207246703 D tration User  Chart Note  West 1/21/2020 9:30 AM 1/14/2020 10:53 AM Yes 1439189
e View Prior Transcriptions with or without w emonsiraton User ChartNote, West 1721/ e -
?, [] 205798180 Demonstration User  Chart Note  East 1/17/2020 1200 AM  2/16/2014 6:06 PM Yes 4765204
the Template. [] 198807816  Demonstration User ChartNote West  1/15/20205:51AM  8/20/2019551 AM  Yes
. . . . @, [J 210395708 Demonstration User Chart Note  West 1/12/2020 1200 PM  3/12/2020 12204 PM  Yes 7243473
e Select multiple transcriptions to view [] 205973080  Doctor Share Chart Note 121182019 934 AM  12/18/2019 934 AM  Yes
1 @, [] 2os79a147 Demonstration User Chart Note Hospital 11/17/2019 115 PM  2/16/2014 6:04 PM Yes A7a5081
and compare using the check boxes. A ‘ B
2. [] 203599593 Nuance V. Jacoby Chart Note  West 11/9/2019 9:45 AM 11/11/2019 401 PM  Yes 31557674
single window opens, displaying the B, [ 205798203  AtendingDoctor  ChartMote West  11/8/201910:15AM  2A6/2014506PM  Yes 4765184
transcriptions separated by a et ot for T 208158653 DOODO O 004/009
Transcription ID heading. popend to Prior | Remoue spoend USSR i i Wil Viewswith Temolate|  view 1| Close

e Use the Append to Prior button to
append the active transcription to a previously typed document or Remove Append to sever such a connection.
e Use Retrieve and Correct to open the dictation in the editor and make any changes.
e Click the audio icon &, to listen to the dictation. Playback controls will appear at the bottom of the window. Audio
shortcuts are supported.

o Find Existing: Search the local backup directory for existing transcriptions if InScribe crashes or if a TID is
accidentally checked in or re-pooled.

Insert
— Clinician: Search the Client for available Authors. (Hotkey: Ctrl+Shift+Space)

— Associate: Search for an associate to add to the

= Associate Search — [m] ®

document. (Hotkey: Ctrl+Alt+Space)

Last Name: ch City: Search
. . . First Name: State:
When you click OK, a list of four different formats appears, Speciaky: Zip W]
such as FIRST LAST and PREFIX LAST. Click one to select |[ R P ‘
ull Name pecialty Delivery Type Business Name Address

and insert it into the document at the current position of the [ Hank M. Chilo _:Pediatrics | Mail_____|Children's Medicine |98 Hilltop Dr;_ste]
|

cursor w_iChris Fax CM Busn
o Select Associate Format - O X Displaying page 1. <«
Select the required Associate format. | ESODemo | Benchmark |
Hank Chilo Associates Found. Cancel
Dr. Chilo

Dr. Hank M Chilo M.D.

Hank M Chilo

98 Hill Dr

Ste 2

Fl2

Minneapolis, MN, 12345

— AutoText: Open the AutoText editing window. (Hotkey: F10 or Ctrl+Shift+T)

— Problem List: Insert the problem list, if available, at the cursor. (Hotkey: Ctrl+Alt+)
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Edit
— Patient: Edit Patient Information (Hotkey: Ctrl+Alt+E)
Append Transcription n
— Append/Unappend: Append or Unappend this transcription to an existing transcription | ¢.; the Transcription ID to which this
by TID number. (Hotkey: Ctrl+Shift+A) document should be appended:
[ |
— Problem List: Open the Problem List editing window. This feature is infrequently used.
(Hotkey: Ctrl+Alt+P) oK
Lists ' j i

— Commands: View a list of available commands for various InScribe panes including s
Carbon Copies, Additional Authenticator, Comment Tags, Comments, and Discrete Data. =R
e & o
Addi Auth: ©
Comment Tags: &
Comments: @

Discrete Data: v

ShadowScribe
These options are only available when editing ShadowScribe or structured documents.

Note: “Add Section” and “Add-Subsection” actions can be added to [ o |
the Function Keys. D ‘

— Add Section: Add a new Section Heading after the currently l SeCt'O" '
selected section. (Hotkey: Ctrl+Alt+H)

Add Section
Add Sub-Section
Move Section Up

— Add Sub-Section: Add a new Sub-Section after the currently
selected section. (Hotkey: Ctrl+Alt+J) g
— Move Section Up: Re-order the currently selected Section |E

above the previous Section. (Hotkey: Ctrl+Alt+, ) Move Section And Sub-Sections Up

— Move Section and Sub-Sections Up: Re-order the currently MoveSeetior Do

selected Section and all child Sub-Sections up above the
previous Section. (Hotkey: Alt+Shift+, )

Move Section and Sub-Sections Down

Delete Section

— Move Section Down: Re-order the currently selected Section
below the following Section. (Hotkey: Ctrl+Alt+.)

Delete Section and Contents

ﬂuwggbuaa

Section Properties

— Move Section and Sub-Sections Down: Re-order the currently
selected Section and all child Sub-Sections below the following B ; d
Section. (Hotkey: Alt+Shift+) Bl Make Section Sub-Sechon

— Delete Section: Delete the selected Section heading. The contents of the deleted section will be added to the prior
Section. (Hotkey: Ctrl+Shift+\)

— Delete Section and Contents: Delete the selected Section heading and the entire contents of the deleted Section.
(Hotkey: Ctrl+Alt+\)

— Section Properties: Edit the Title and Section Code. (Hotkey: Ctrl+F6)
— Make Sub-Section Section: Promote a Sub-Section to Section status. (Hotkey: Ctrl+,)

— Make Section Sub-Section: Demote a Section to Sub-Section status. (Hotkey: Ctrl+.)
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Format Tab and Editing Window

The buttons available in the editing window are duplicated in the Format Tab for users who choose to hide the Editor bar
(View tab> Editor). Those functions commonly associated with standard text editors are found on this tab and allow users
to organize the document, add tables, lists, and other common document features.

E Home  Transcription  Data  Format | View

8 Find & Select All %o Delete Left = Go To Start i= Numbered List | [ Insert - -
b Replace ‘g Toggle Case % Delete Right = Go To End = Bulleted List - -
8 hep 99 g :

[ Paste g Remove Content After Cursor = Horizontal Line e

Transcription Functions

Clipboard
— Cut: Copy the selected text to the clipboard, but remove it from the editing window. (Hotkey: Ctrl+X)

— Copy: Copy the selected text to the clipboard and leave the text in the editing window. (Hotkey: Ctrl+C)
— Paste: Paste selected text from the clipboard at the cursor in the editing window. (Hotkey: Ctrl+V)

— Undo: Undo the last action taken or last text typed. (Hotkey: Ctrl+2)

— Redo: Retake the last action or replace text that was removed with the “Undo” function. (Hotkey: Ctrl+Y)

Editing
— Find: Search for keywords in the transcription text. (Hotkey: Ctrl+Shift+F)

— Replace: Search for a keyword string and replace it with a different string of characters. (Hotkey: Ctrl+Shift+H)
— Remove Content After Cursor: Delete all text after the cursor. (Hotkey: Ctrl+Shift+Delete)

— Select All: Highlight all text in the transcription body. (Hotkey: Ctrl+A)

— Toggle Case: Toggle text case between sentence case, upper case, and lower case. (Hotkey: Ctrl+Alt+U)

— Delete Left: Delete the word to the left of the cursor. (Hotkey: Ctrl+Backspace)

— Delete Right: Delete the word to the right of the cursor. (Hotkey: Ctrl+Delete)

— Go to Start: Jump to top of report. (Hotkey: Ctrl+Alt+Home or Ctrl+Home)

— Go to End: Jump to bottom of report. (Hotkey: Ctrl+Alt+End or Ctrl+End)

Text
— Bold: Begin transcribing text with Bold formatting or change selected text to bold. (Hotkey: Ctrl+B)

— ltalic: Begin transcribing text with Italic formatting or change selected text to italic. (Hotkey: Ctrl+l)
— Underline: Begin transcribing text with Underlined formatting or change selected text to underline. (Hotkey: Ctrl+U)
— Remove Formatting: Remove all formatting tags from selected text.

— Strikethrough: Begin transcribing text with Strikethrough formatting or change selected text to strikethrough.

’ DeliverHealth
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— Superscript: Begin transcribing text with superseript formatting or change selected text to superscript.
— Subscript: Begin transcribing text with subscript formatting or change selected text to subscript.
— Open in Word: Open the transcription in Microsoft Word (available for unstructured documents).

Paragraph
— Align Left: Align transcription text to the left. (Hotkey: Ctrl+Alt+L)

— Align Center: Align transcription text centered. (Hotkey: Ctrl+Alt+C)

— Align Right: Align transcription text to the right. (Hotkey: Ctrl+Alt+R)

— Align Justified: Align transcription text with both the left and right margins. (Hotkey: Ctrl+Alt+F)
— Unindent: Unindent transcription text to the left. (Hotkey: Ctrl+Shift+M)

— Indent: Indent transcription text to the right.

— Insert Page Break: Insert a manual page break (available for unstructured documents).

— Show Glyphs: Show formatting tags.

Lists
— Numbered List: Toggle a numbered or ordered list (available for unstructured documents). (Hotkey: Alt+Shift+V)

— Bulleted List: Toggle a bulleted or unordered list. (Hotkey: Ctrl+Alt+V)
— Horizontal Line: Insert a page width horizontal line (available for unstructured documents).

Table Functions
— Insert

o New Table: Opens the table wizard and inserts the table with selected number of columns and rows at the cursor.
o Insert Row Before: Add a new row above the row the cursor is currently positioned in.
o Insert Row After: Add a new row below the row the cursor is currently positioned in. (Hotkey: Alt+Shift+l)
o Insert Column Before: Insert a column to the left of the column the cursor is positioned in.
o Insert Column After: Insert a column to the right of the column the cursor is positioned in.
o Insert Cell Before: Insert a single cell to the left of the cursor position.
o Insert Cell After: Insert a single cell to the right of the cursor position.
— Delete
o Delete Table: Delete the entire table and contents.
o Delete Cell: Delete the single cell the cursor is positioned in.
o Delete Column: Delete the column and contents the cursor is positioned in.

o Delete Row: Delete the row and contents the cursor is positioned in. (Hotkey: Alt+Shift+D)
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— Properties

o Table Properties: Access properties settings that affect the entire table.

o Cell Properties: Access properties settings that affect the cell the cursor is positioned in.
— Merge:

o Merge Cells: Merge selected cells into one cell.

o Merge Cell Right: Merge the currently selected cell with the cell to the right.

o Merge Cell Down: Merge the currently selected cell with the cell below.

— Split Cells: Split the selected cell into two equal cells.

View Menu

Use the View menu to view information about transcription production and to change the appearance of InScribe.

File Home Transcription Data Format View
/ ;SOA Feedback ()} Character Map @ Dictation Details ‘ L Edltorl | [ Lists ‘ [ Reset Sizes | Comments | (5] 4, Zoom In ‘
: I Count Lines ' ‘%Demographics I@ Status Bar| [T] Maximize Editor Discrete Data B =, Zoom Out "
Log Work Pool § = . Zoom Jump
7] Shorteuts [l Configure Foot Pedal ‘ Ratings ‘ [7] Ribbon Shortcuts -
Dialogs
— Log: Display the log of completed transcriptions. The = Tansaiption Log - 0 x
log is for informational use only. The actual line count Log For: | 172012020 21 throuah | 2/2072020 &l | gt e 1
. . . . . earc otal Standard Lines:
may change based on transcriptions in QA, which will Client | DateType: | Date Delivered - i shadousor Unds
otal Qualified Lines: 25
not be reflected in this log. (Hotkey: Ctrl+L) Grandi Total Lines: 424
Transcriptic Patient ID  PatientMNai Clinician  Doc Type Location  STD Lines ASR Lines QT Lines  Receipt Co
o Log For Deflne the date range to Search Completed 207246703 5271032  GREG WHIT Demonstra” Chart West Clinic 4 o 0 1439189
o 207247895 2593 LYNN TINSI Demonstra Consult  Main 82 0 105 1439831
transcriptions. 207276029 5271123 SAMANTH: Demonstra Consult  Main 23 0 99 1456359
207410932 5271163  WORREL €I Demonstra CDocO1  Main 6 0 0 1639146
o Cllent Leave the C“ent f|e|d blank to |nclude a" This log is for informational use only. The count may change based on transcriptions in QA, which will not be reflected in this log.
X . o k Leave the dient field blank to include all clients in your results.
clients in the results or search for a specific client. Transcriptions Found. TincludePI Pt | sae || ok |

o Date Type: Search by Date Transcribed or Date Delivered.

o Search: Initiate the search using the selected parameters.

o Include PHI: Include confidential Patient Health Information on the report.
o Print: Print a copy of the Transcription Log.

o Save: Save an electronic copy of the Transcription Log.

o OK: Close the transcription log.
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— Work Pool: Displays a list of transcriptions available for the MT currently logged in.

o Transcription ID: The unique job identifying
number (TID).

o Client: The hospital or facility where the
Transcription originated.

o Clinician: The author who dictated the job.

o Doc Type: The work type the dictation was
created with.

o Location: The location the dictation was
created with.

(Hotkey: Ctrl+Shift+P)

o Priority: The priority level assigned to the dictation. Lower numbers indicate higher priority jobs. By default,
standard priority dictations are assigned a priority of 4 and STAT dictations are assigned a priority of 2.

o Date Received: The date the system received the dictation from the author.

o Length: The length of the dictation’s audio.

o TAT: Turnaround time is the total amount of time accumulated from when a dictation is received to when a

transcription is delivered to InQuiry.

o Receipt Code: The dictation’s receipt code, a code from the InTouch server.

— QA Feedback: View Feedback for transcriptions reviewed in QA.

(Hotkey: Ctrl+Alt+Q)

— MT Notes: View notes or instructions from the Transcription
Company regarding the selected dictation. MT notes can include tips
and information regarding the production of the transcriptions.

MT notes are displayed before the appointment or order window
appears, ensuring that you will always see any notes or instructions

before making a visit selection.

— Shortcuts: View a list of all hotkeys available in InScribe. Type into
the filter text box to quickly find the shortcut you're looking for.

Double-click a hotkey in the list to highlight it and make it
a favorite. (Double-click again or click Reset to remove it

as a favorite.)

Click the ‘Only Show Favorites’ check box to see a list of
your favorite shortcuts. (Hotkey: Ctrl+Shift+S)

. Transcriptions in Paol - ] X
Transcription Id  Client Clinician Doc Type Location  Priority Date Received Length  TAT Receipt Code
2091485906 ESODemo Chart Note 3 2/19/2020 5:12 AM  00:00:00 -608.82
200747776 ESODemo Chart Note 3 9/30/2019 5:41 AM  00:00:00 -585.81
210998832 ESODemo  Demonstration User Chart Note West 4 3/31/2020 951 AM 000705 -10564 4765184
210998836 ESODemo  Demonstration User Chart Note West 4 3/31/2020 9:51 AM  00:01:19 -10564 4765188
210998841 ESODemo  Demonstration User Chart Note West 4 3/31/2020 9:51 AM  00:01:09 -10564 4765198
210998844 ESODemo  Demonstration User Chart Note West 4 3/31/2020 9:51 AM  00:01:11 -105.64 4765199
210998847 ESODemo  Demonstration User Chart Note West 4 3/31/2020 9:51 AM  00:00:44 -10564 4765201
210998849 ESODemo  Demonstration User Chart Note West 4 3/31/2020 9:51 AM  00:02:38 -10564 4765204
210998852 ESODemo  Demonstration User Chart Note West 4 3/31/2020 9:51 AM  00:01:23 -10564 4765206
210998853 ESODemo  Demonstration User Chart Note West 4 3/31/2020 9:51 AM  00:01:08 -10564 4765208
211075012 ESODemo  Demonstration User Chart Note Hospital 4 4/2/2020 1:30 PM 00:00:06 -53.98 9345046
53 records. Last Updated at 4/6/2020 4:29 PM Refresh Print ‘ | Close
"2 MT Notes — O X

Enter Date of Service correctly on Telephone Correspondence Reports
dictated by Dr. Doc Test.

[] Do not show this note again, unless there are

== InScribe Keyboard Shortcuts = (] X
() Navigation and Selection
Move To Previous Paragraph Ctrl+Up
Move To Next Paragraph Ctrl+Down
Move To Previous Word Ctrl+Left
Move To Next Word Ctrl+Right
Move To Top Of Report Or Section Ctrl+Home
Move To Bottom Of Report Or Section Ctrl+End
Move To Start Of Line Home
Move To End Of Line End
Select Previous Paragraph Ctrl+Shift+Up
Select Next Paragraph Ctrl+Shift+Down
Select Next Word Ctrl+Shift+Right
Select Previous Word Ctrl+Shift+Left
Select Start Of Line Shift+Home
Select End Of Line Shift+End
Select All Ctrl+A
() Editing
Add Section Ctrl+Alt+H
Filter: Clear |
[_1 Only Show Favorites | I Expand All \ ‘ =1 Collapse All | Print J | Reset Close |
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— Character Map: Open the character map for special characters. o oo *
ot T, Help.
V[ T&[$[%[& "[(O]* +[. -[.[/[0[1][2]3]4]~
586|789 : :|<=|>?@ABCDEFGH
I JIKILMNOIP QR S|TUVWXY|Z|[
1% _“Talbc|de|f glhiljk[imnlop
qr_st'uvwxyz(|)~ i'é:E:u¥
I NCNRRE R EEERINLIE RS
Solanis AAAARAEGEEEE I
I 1/BNOOCOOO|=x @UUUU|Y PR aa
aaladleceleelei|ii|ialnaslas
o ~euaauly ply Ala Ala AlaCle|C e
— Count Lines: Perform an ad hoc line count. (Hotkey: Ctrl+T) Line Counts |
. . . Line C it (Standard Ch: ters / 20): 27
— Configure Foot Pedal: Configure a three button USB foot pedal for use with e
InScribe. Note that not all foot pedals are supported. Qualified Lines: 26

— Dictation Details: View basic details of the dictation, such as Patient ID,
appointment date/time, clinician, document type, etc. (Hotkey: Ctrl+Shift+?)

Toolbars

— Show/Hide Toolbars: Toolbars highlighted in orange will be displayed in the InScribe editor window. Click to de-
select the toolbars to hide them.

o Editor: This toolbar contains the editing functions that are available in the Format Tab.

o Demographics: This toolbar contains functions to search for patient demographics.

o Ratings: This toolbar is used when creating QA feedback.

o Lists: These toolbars control Associate, Additional Authenticators, Comment Tags, and Comment functions.
o Status Bar: Displays MT Pool and Feedback counts and InScribe activity statuses.

o Ribbon Shortcuts: Displays the shortcut with the function title for any ribbon item that has an assigned hotkey.

View
wracter Map ¥ Dictation Details| CtrI+Shiﬂ+?| | _] Editor ‘ | || Lists |
nt Lines |;§.Demographics |@ Status Bar|
nfigure Foot Pedal | Ratings | || [7] Ribbon Shortcuts ]l
Panels

— Reset Sizes: Resizes all panels to their default size and position in InScribe.

— Maximize Editor: Hide the Demographics info, list of downloaded dictations, Associates, Additional Authenticator, and
Comment panes to enlarge the viewable area of the Transcription Editor. (Hotkey: Ctrl+Tab)

— Comment: Click to display the comments list.

— Discrete Data: Click to display the Discrete Data list. Some document templates define fields that are specifically
named by your transcription company. This allows the text used to replace that field to be referenced by a field later in
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the document or by an interface. The Discrete Data window allows you to see what fields have been identified and
named, and what values have been associated with each field. Please note that this feature is rarely used.

Note: ‘Comment’ and ‘Discrete Data’ cannot both be selected at the same time.

Zoom Setftings @ ZoomIn
(3, Zoom Out

Zoom allows the apparent size of the text to be adjusted for visibility without altering the actual text size on
the finished document. Select the desired zoom setting from the drop-down menu or use the Zoom In and
Zoom Out buttons to select incrementally.

_ @Zoomln. horease the apparent size of the text.

— S ZoomOut. pecrease the apparent size of the text.

Jump Functions
Use the Jump Function to quickly navigate to different Panes in InScribe. (Hotkey: Alt+J) Once the Jump
process is enabled, InScribe will prompt with letter keys until the cursor is in the desired position.

| B3 |inScribe - AA o a X
Home Transcription Data Format View e -
/ 8 QA Feedback {) Character Map @ Dictation Details | ||_] Editor | | JLists [T Reset Sizes Comments (@ Zoom In »
MT Notes  E Count Lines /3 Demographics lo Status Bar [~ Maximize Editor Discrete Data (=, Zoom Out
Log  Work Pool ¥ Zoom Jump
[#] shortcuts 1l Configure Foot Pedal Ratings [Z] Ribbon Shortcuts Z

Dialogs Toolbars Panels Zoom Jump

élmpmg 7 it il e Ve TRAN: AA(12839I .
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Advanced Table Functions

Advanced Table functions allow for control over the size and appearance of a table.

Table Properties
Table Properties affect the size and appearance of the entire table. To access the table =l =
properties, place the cursor in any cell belonging to the table and press the table properties o A

button. Table properties contains four tabs: Table, Row, Column, and Cell. :
Table Properties

Table Tab:
1~ 75bic Properties ——
— Width: The width of the page the table occupies, measured in pixels or i e M) t
percentage. fo= ) '
— Alignment: The alignment of the table on the page. Options are Left, || Arignment
Right, and Center with an additional option to indent. .
— Default Cell Padding: The amount of space between the text and the cell | o camame
walls. Seme for al sices
— Default Cell Spacing: The amount of space between individual cells. ]| sottom 3t Rt | 3p[d
7| Default cell spacing
— Table Direction: The direction the cursor moves through the table. Options 7 sengbemeencens [ oex =
are left-to-right (default) and right-to-left. ]| Tatte direction
Table Frar‘e‘rtie: ‘h
I feble  Row | Column  cen £
Row Tab: Row Index 1: f
Slze
— Size: The height of each row. T = at lenst ;
— Options: Repeat as header row at the top of each page. e
— Previous/Next Row Buttons: Move backward/forward through rows.
3 ]
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Column Tab:

— Size: The width of each column.

— Previous/Next Column Buttons: Move backward/forward through

columns.

Cell Tab: Explained below under Cell Properties.

Table Border Properties

Border properties allow you to customize borders and contains two tabs: Table

Teble Praperties

| mbie

Colurmn ing Bz 1

| Size

Recat Al

March 2021
——
Row  Column | Cell i
s
5
Prefered width Measure i
Previous Column Next Column
oK Cancel
L= g lic = Rglic = )

Borders and Cell Borders. To access the border properties, place the cursor in the

cell and press the table border properties button.
Table Borders Tab:

— Setting: The position of the table border. You can also click on
the position pane on the right side of the dialog box.

— Style: The type of table border.
— Color: The color of the table border.

— Width: The thickness of the table border.

Cell Borders Tab:

— Setting: The position of the cell border. You can also click on
the position pane on the right side of the dialog box.

— Style: The type of cell border.
— Color: The color of the cell border.

— Width: The thickness of the cell border.

Cell Properties

Cell Properties affect the size and appearance of individual cells. To access the cell properties,

place the cursor in the cell and press the cell properties button.

41

Table Border Properties

§Teble Borders
#| Table Borders
Setting:

None

=
B -

| B e

1 Custom

Reset All

Cell Borders

Style:

Click on the image or uss the
Buttons to apply borders

L

4. Teble Barders

#| Table Borders
Setting:

None
=
g Custom

Reset All

Cell Borders

Style:

1px

B

oK Cancel

1 1 1

Cell Properties
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— Background: Color of the individual cell background. 1 Table Properties —

Table Row Column | Cell
— Vertical Alignment: The vertical alignment of the text inside the cell. Background 1

Options are Top, Middle, and Bottom.

Calor: [ -

Vertical Alignment

i[=HI=Ri=] |

Middle Bottom

— Text Alignment: The horizontal alignment of the text inside the cell.
Options are Left, Center, Right, and Justified.

— Cell Padding: The amount of space between the text and the cell walls.

Text Alignment

Left Center Right  Justified

<| Cell Paddings
Same for all sides
Top: IpK s Left 3px o

Bottam: Ipx T Right Ipx T

Options =

Home Tansaiptir  Se€l€ct Options from the File Menu. The options change how InScribe behaves and allow the
transcriptionist to customize the workspace to optimize production.

Save

="
O Stop Downloads

{ Preview Transcription
= P

l@ Explore

Backup Personal Files

.. Restore Personal Files

"% InScribe Options - O X

Options
: i e .. General options for working with InScribe
x Exit Prompts padl
I Playback Startup Options
Editing [] Download Dictations on Startup
[] Hide Available Upgrades

Foot Pedals
spelling Account Options
Shortcut Keys ‘Change Password‘ ‘Modn‘y Acccunl‘
Advanced BenchMark KB

You have a Benchmark KB site license that is controlled by your administrator.
Language
Language = English v

App must be restarted after changing the language.

OK I l Cancel
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General

General options for working in InScribe.
— Startup Options

o Download Dictations on Startup: Deselecting this option will prevent InScribe from automatically requesting a
dictation upon login.

o Hide Available Upgrades: InScribe will not prompt to update

. . "2 Change Password x
when an update is available. ¢

. Your password must meet the following requirements:
— Account Optlons ® Passwords are case sensitive.

® Passwords require upper case characters.
o Change Password: Change the password used to log into

- Provide your current and new password below
the current InScribe account. y P

Company DEMO
o Modify Account: Change the personal information Username aa
associated with your account (name, email, phone number). Current Password ||

New Password

— Benchmark KB

Verify Password

o User Name: The login ID assigned by Benchmark. Change

o Password: The password for the Benchmark ID.

o Register with Benchmark KB: A link for new Benchmark KB users.

— Language: Currently InScribe is supported in English and Swedish.

Prompts
Change how InScribe prompts and notifies you.
— Job Completion
o Prompt to Mark for QA: Options are Always, When in Question, When in Question and Unmarked, and Never.
= “When in Question” refers to jobs in which the patient name or transcription text contains unexpected characters
e Patient Name: Asterisk, underscore, and question mark * _ ?
e Transcription text: Asterisk, underscore, question mark and square brackets * _?[]

o Prompt to Mark for QA when Comments or Comment Tags Exist: Toggle to Mark for QA based upon Comments
and Comment Tags.

Exit InScribe

— Application Close

‘ Do you want to exit from InScribe?
o Show Shutdown Confirmation: Enables a Shutdown Confirmation 9/

When you exit, any dictations that are not typed will be

popup to prevent accidenta| |Og Off checked back into the server. If you have a transcription that
has net been completed, you will be prompted to Complete,
Check In or Keep these transcriptions when you press Yes.

— Notifications

o Prompt When High Priority Job Received: Display a notification if a e ﬁ
higher priority (STAT) dictation is downloaded to the queue.
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o Prompt When Unselected Job is Removed from Your Pool: Display a notification if a dictation is removed from
your downloaded queue by the Transcription Manager or automatic check-in.

o Prompt When Queue is Empty and New Work is Available: Display a notification if no dictations are downloaded
and work is added to the pool.

o Prompt When Clinician Field Changes: Display a notification if the Author field is updated.

o Prompt When Appointment Date is After Dictation Date: Display a notification if the Appointment date is later
than the Dictation Date.

o Prompt When Dictation Has Not Been Played Within [ ] Seconds: Display a notification if the entire audio file has
not been listened to.

Playback

Playback Options control how InScribe’s audio player performs.
— Control Functions

o Continue Playback After Rewind or Fast Forward: Activate this option and the player will continue playback after
performing Rewind and Fast Forward. Otherwise the player will pause.

o Separate Play and Pause Functions: Enable to prevent the play button, shortcut or F-key from pausing the
dictation playback.

o Remember Volume and Playback Rate by Clinician: Enable to allow InScribe to automatically adjust Volume and
Playback rate to the last used settings per Author.

— Time Adjustments
o Rewind [ ] Seconds: Control the increment that InScribe Rewinds per button press.
o Fast Forward [ ] Seconds: Control the increment that InScribe Fast Forwards per button press.

o Pause [] Seconds: Control the increment that InScribe automatically Rewinds when the dictation playback is
paused then resumed.

— ShadowsScribe Playback
o Attach Voice Cursor on Play: Attach the Editing Cursor to the Voice Cursor when the dictation is played.

o Attach Voice Cursor on Rewind and Fast Forward: Attach the Editing Cursor to the Voice Cursor after Fast
Forward and Rewind actions are performed.

o Attach Voice Cursor on Jump to Index: Attach Editing Cursor to the Voice Cursor after Jump to Index action is
performed.

o Change Voice Cursor Color: Change the Color of the Voice Cursor to suit user preference.

Editing

— Auto Saving
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o Automatically Save Job Every [ ] minutes: Control the frequency that InScribe will create a save file for the
selected transcription. Increase the time to increase computer performance. Decrease time to perform a greater
number of backups.

— User Interface
o Demographics Highlighter Color: Change the color of the label text in the Info Pane.
o List Document Types by Description: Enable to list Document Types by their descriptions instead of their names.
o Resize List Panels on Focus: Reset the size of List Panels to their default.

o Hide Pool Count: Hide the number of Dictations in the Transcription Pool displayed in the status bar at the bottom
of InScribe.

o Use Orders Tab: Enable to display a separate Orders tab in the Info pane.
— Patient and Appointment Options

o Search for Appointment/Orders When Dictation Loads at Transcription Level: Automatically search for an
appointment if patient information is attached to the dictation when it is loaded at the standard transcription level.

o Search for Appointment/Orders When Dictation Loads at QA levels: Automatically search for an appointment if
patient information is attached to the dictation when it is loaded at any QA level.

o Show Single Patient When Not an Exact Match: Show a patient listing when the result is a single patient, but is
not an exact match. Otherwise, the patient information will automatically import.

o Show Single Appointment/Order: Show the Appointment Search window even if only one appointment option is
available for the patient. Otherwise, the appointment information will automatically import.

o Automatically Load the First Appointment: Automatically load the most recent appointment, prior to or equal to
today’s date, for the patient. Otherwise, the Appointment Search window will display all available appointments.

o Automatically Select Single Patient from Clinician Listing: Automatically import patient information if only one
patient is available for the Author for the selected appointment date.

— AutoText
o Automatically Expand AutoText: Enable the use of the AutoText word expansion feature.

o Jump to Next Bracket After AutoText: Enable and InScribe will automatically jump to the next [field] in the
document. Otherwise use the Fields command to jump to the next field. (Hotkey: F1)

o Start Bracket Search at the Beginning of the Document: InScribe will begin searching for [fields] at the start of
the document after the last [field] has been populated.

o Show AutoText Listin Comments: Add a drop-down list to select from AutoText entries Comment & 38
marked for use as a Canned Comment in the Comments list. ( z|

1]
o Use All AutoText as Canned Comments: Enable to display all AutoText entries in the drop- H
down list in Comments.

o Use Double Space After Sentence: InScribe will enforce two spaces after sentence punctuation.
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— Templates

o Get Document Template When the Location is Changed: InScribe will prompt to
load a new Document Template upon Location change. Note that if the transcription
contains text you will be prompted to choose to overwrite the existing text with the new
template text, insert the new template text at the cursor, or keep the existing
transcription text without loading the new template text.

o Process Bracketed Fields After Inserting Dictation Template: Allow InScribe to
jump to first bracketed [field] in a dictation template after inserting. If “Automatically Fill
Template Fields” is set as “Always,” InScribe will also automatically populate any [field]
it has data for.

o Automatically Fill Template Fields: Allow InScribe to automatically populate any
[field] that it has data for. For example, if Date of Birth is entered into the Info Pane,

March 2021

Patient ID: [PATIENT ID]

Patient Name: [PATIENT NAME]
Gender: [GENDER]

Birthdate: [BIRTHDATE]

Age: [AGE]

Order #: [ORDER NUMBER]

Appt: [SERVICE DATE]

Clinician: [PHYSICIAN NAME]

Dict Date: [DICTATION DATE]
Current Date: [DATE]

U-Field 1: [USER_FIELD_1]

U-Field 2: [USER_FIELD_2]

U-Field 3: [USER_FIELD 3]

U-Field 4: [USER_FIELD_4]

U-Field 5: [USER_FIELD_5]

Problem List Section: [PROBLEMLIST:]
Dictation Template: [TEMPLATE:]
Dictation Template Use: [TEMPLATEUSE:]

InScribe will automatically calculate the answer for the [Age] field or can populate the [Birthdate] data field within the

transcription text.
e Options are Always, Never, and Prompt.

e On theright is a list of [Fields] that InScribe is capable of populating/calculating.

Foot Pedals

Foot Pedals are used by InScribe to control the Play, Pause, Fast 3 o Opins
Forward, and Rewind playback functions of the dictation, freeing up the
typists’ hands from those tasks. If InScribe is open and a foot pedal is e

Playback Options

plugged in, InScribe will prompt the user to configure the foot pedal. Gatng ] Use PP ot peda o topge plpback

The foot pedal configuration screen can also be opened via the File =

Shartcut Keys

Advanced

— Options:

o Use Play/Pause Foot Pedal to Toggle Playback: Select this
option to play audio by pressing and releasing the center pedal and
to pause by pressing and releasing again.

Configuration

— Status: The status window displays a list of all connected foot
pedals. A check in the box of the “configured” column indicates that
the device has been configured and will work with InScribe.

! Canfigure foot padals for use with InScribe,

Spelling Configured Name

Menu, then Options, then Foot Pedals. 0 | vecFooteaa

o Foot pedals that are un-plugged from the computer will be
remembered and will not have to be reconfigured.

— Foot Pedal Configuration Wizard: Press to launch the Foot Pedal Configuration Wizard.
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Configuration Wizard

— Start the wizard by either plugging in a USB foot pedal, or by selecting the Configuration
Configuration button.

:Foot Pedal Configuration Wizard

r,f Unconfigured Foot Pedal Detected [BJ Lﬂlﬁ

An unconfigured foot pedal was connected. Do you want to configure and use this
foot pedal now?

VEC Foot Pedal

Configure
Configure this foot pedal and use it.

Ignore
Ignore this foot pedal for now. It may be configured later.

'_‘- Configure Foot Pedal @J E‘M
— Press and Release the Play Pedal.

Configuring Foot Pedal

VEC Foot Pedal

Press and Release the Play Pedal.

4 Configure Foot Pedal = =G N

— Press and Release the Rewind Pedal.

Configuring Foot Pedal

VEC Foot Pedal

configured.

Press and Release the Rewind Pedal.

— Press and Release the Fast Forward Pedal. 4 Configure Foot Pedal = =lE ‘

Configuring Foot Pedal

VEC Foot Pedal

Play

edal is configured

Rewind Pedal is configured.

Press and Release the Fast Forward Pedal.
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— Configuration Complete.

Spelling

Control Spellcheck and Dictionary options.

— Configuration

March 2021

Configuration Complete -

IOI Device configuration complete.

o Check Spelling as You Type: Allow InScribe to display the red line underneath misspelled words as you type.

— Correction Options

o

(0]

(0]

Ignore Words in ALL CAPS

Ignore Domain Names (Web Addresses, etc.)
Ignore mixeD CaSE

Ignore Words with Digits (Hellol)

Ignore Numbers (12345)

Ignore Capitalized Words (First Letter Caps)
Split Hyphenated Words for Spelling (auto-text)
Split Contracted Words for Spelling (couldn’t)
Allow Possessives on Words (patient’s)

Report Uncapitalized Words (canada)

Report Doubled Words (the the)

Report mixeD CaSE Words

Report Words with Digits (Hello2)

Suggest Split Words (theboy = the boy)
Suggest Phonetic Words

Suggest Typographical Words

Case Sensitive (Treat canada and Canada differently)

Check Word Parts (dumptruckdriver would be correct)
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o Capitalize First Letter of Sentence as You Type
— Reset Options: Reset spelling options back to default.

— Dictionaries: Press the Custom Dictionaries button to choose which dictionaries will be used. Dictionaries on the right
side of the Custom Dictionaries window are available for use. Dictionaries on the left side are currently active.

o Compiled Dictionaries: Pre-made dictionaries that include Standard English and British dictionaries, as well as
medical dictionaries. Benchmark KB can also be enabled to include Stedman’s Medical Dictionary. See Options>
General for more information.

o User Dictionaries: Dictionaries that contain words that are added by the user.

Shortcut Keys

— Action Keys: Customize the actions performed by the Action Keys F1 through F12.
o Reset Actions: Reset the Action Keys to their default settings.

— Options
o Disable Shortcuts for Re-Pool and Invalidate: Disable these two shortcuts to prevent accidental usage.
o Shortcuts: Choose the Shortcut configuration.

e Use Modified Shortcuts: This is the default option and has been optimized for InScribe version 7. This is also the
shortcut set used in this manual.

e Use Classic Shortcuts: Use the original shortcuts from prior versions of the software.

e Use ASR Enhanced Shortcuts: Use a shortcut configuration optimized for use with ShadowScribe editing (Voice
Recognition QA).

o Export Shortcuts: Allows you to save a copy of the shortcuts to a name and location of your choice as an .xml file to
edit/customize in Notepad++.

o Import Shortcuts: Allows you to import the edited exported .xml file into InScribe. After successful import, “Use
Custom Shortcuts” will be displayed in the shortcuts drop-down.

Advanced

— Shortcuts

o Use Global Function Keys: Allow the Action Keys (F1 through F12) and other (Hotkeys) to be active even when
InScribe is not the primary active program in Microsoft Windows.

— Prompts

o Automatically Check for New Dictations Every [ ] Minutes: Enable InScribe to check for available dictations at
the specified interval.

o Display JavaScript Errors: For troubleshooting purposes, display error message for InScribe.
— Foot Pedals

o Foot Pedals Remain Active While Other Applications are Active: Allow the InScribe audio to be accessed with
the foot pedals even when InScribe is not the primary active program in Microsoft Windows.
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— Playback
o Audio Player
e InScribe: Use the default InScribe player.
e Other: Use an alternate media player currently installed on your machine.

o Audio Player Path: The file path to an alternate media player; only enabled when Other is selected for the Audio
Player.

o InScribe Wave Player: For researchers studying structured documents, this feature uses a waveform control to
navigate and visualize the audio. A cursor in the waveform indicates the current playback time.

When the “Show Waveform” button is 0:00/1:16 @ Attach Selection

toggled to ON, the waveform control W) (@) 3) W) %) 2)100% 53 Move Playback To Cursor

appears in the lower part of the editor. 2% Q0O 2)100% = &

Ahdominal €71

l("C' 30

A B 1 e g - e & L R B L L L R L R e

s 9 & & o Add Auth O Comment Tags O Comment b

For sections with timestamps at the beginning and end, clicking on the section title plays the audio between the
timestamps. This functionality requires the "Use Alternate Timestamp Format" option to be enabled.

e Automatic — the default wave player for InScribe
o WASAPI — an alternate wave player option
e WaveOut — an alternate wave player option
— Field Behavior
o Use Alternate Timestamp Format: This option will insert timestamp in milliseconds.
— Data

o Remove Save Folders: This option will remove all prior “Save” folders under this username. By default, InScribe
removes old folders each time you log in, but saves the last two weeks of transcription data. This option will clear all
old data.

o Backup and Restore Personal Files

e Backup to Set: Choose the Backup options to save your AutoText and User Dictionary to a copied location on
your computer, which you can use to switch between sets or simply have a backup copy.
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e Restore from Set: Restore a previous backup of your AutoText and User
Dictionary files.

e Backup to Location: Options to specify where you want to save a backup of your
AutoText and User Dictionary, which you can use to keep a backup on a separate
disk or to move to another computer.

e Restore from Location: Options to retrieve a prior backup of your AutoText and
User Dictionary files.

o Get Recalled Jobs: If one of your jobs has been checked back in (by an automatic
process or manually by a manager) and becomes available in your queue again, you
may press this button to download the typed work you completed prior to it being
recalled.

March 2021

Personal Files H

Choose the Backup or Restore Set options to save
your AutoText and User Dictionary to a copied
location on your computer, which you can use to
switch between sets or simply have a backup
copy.

Choose the Backup or Restore Location options to
specify where you want to save or retrieve a
backup of your Autotext and User Dictionary,
which you can use to keep a backup on a
separate disk, or to move to another computer.

Backup to Set Backup to Location
Restore from Set Restore from Location
Delete Set Close
AutoText is InScribe’s built in Word Expander. It is located on the Data tab (or by pressing - AutoText
<F10>). Word expansion can be as simple as expanding a few characters into a longer word or ol o il
phrase, or as much as entire templates complete with Tables and Ordered Lists. All of the . d.:| X
formatting options that are available in the standard editing window are available in the " -
AutoText editing window. gbboug 3
abotu
abo
. . . abouta
Adding and Removing Entries abouti
aboutthe
On the left side of the AutoText window is a list of all current expansions. abscence
) accesories
— The green “ button creates a new entry. The name entered here will be the short version accidant
of the expansion. Note that InScribe will gray out the “OK” button if the name entered has accomodate
invalid characters or is already in use. S AutoText Name o x
Enter Name
t
— The & save button stores changes made to the selected entry.
[ Goncel |

— The ~ Delete button removes the selected AutoText entry. Deleted entries can be
recovered from backup files.
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— The Find box is a keyword search and will return results for the short © 3 & Field List:
name field. The B8 button initiates a search and the X clears the Find: needle g X B
contents of the search box. rh

needle

A 22-gauge needle

Quick Add Feature

Use the Quick Add boxes to quickly add new AutoText entries. Enter the short form on the left and the long form on the

right. Press the @] button or enter to add and save the entry. This feature is ideal for quickly adding short expansions, but
is not suited for large amounts of text and advanced formatting such as tables and lists.

Quick Add: tpr = the procedure @
ok | [ Close |
AutoText Editing
All of the formatting functions available in the standard editing window are Pedbre|BrU[sxxAh|EEy
available in the AutoText editing window. A detailed explanation of these
functions is available in the Format Tab and Editing Window section. In addition A 2L-Anigk pendle

to the standard formatting options, there are two radial menu options:
— Use as AutoText: This entry is used in the main editing window.

— Use as Canned Comment: This entry is used in the comments pane, but can
also be used in the editing window.

It is possible under the Options Editing section to allow standard AutoText entries @ UsessAuteTest . Use as Conned Comment

in the Comments section.

Fields and Functions

Fields and Functions found in your AutoText creator are advanced template creating functions. Using Fields and
Functions are comprehensively covered in a document found here: https://www.escription-one.com/Software/InScribe

Click here to download: How to use Template Fields and Functions.
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Rating a Transcription in InScribe

QA Ratings & Feedback allows the QA staff to record errors and leave feedback for the prior MT while editing the
transcription. Each time a transcription passes through QA, the QA staff is able to rate the quality of the previous
transcriptionist. The ratings and comments applied by a QA1 staff member will be visible to the original Transcriptionist;
the ratings and comments applied by a QA2 staff member will be visible to the QA1 who worked on this document, and so

on.

Your Transcription Company can determine if these ratings will affect your overall Quality Score, and thus your pay rate
for this transcription. Your company might also choose to utilize this feature to simply provide feedback on the quality of

your work without influencing your pay rate.

Rating Process

If the QA Ratings & Feedback feature has been
configured and enabled by the transcription ccs ©
company, the QA staff will see the Ratings tab in 5 od
InScribe.
The Raﬂng; panel shargs the sam? WII.’IdOV,\’I as the Bones McCoy
Demographics panel. Click on the “Ratings” tab.
(Hotkey: Ctrl+R)
Info ‘ ‘ Ratings
Job Selected.

In the example, the word “work” is misspelled [ 4 | 53 | mdatinscribe -RRsqA ] el
in the first sentence. The process to correct M| Home || Transcription  Detal Format  View 9>
this and add an English Word Misspelling B2 e - 6 B, f8 (B fo ) g2
error is: ER R e N R e sl e

TI[; Client DocType  Clinician Location DictDate  Length Due

1. Inthe Editor panel, delete “wrk” and

type “work”. Jump to the Ratings e
Omitted Dictation (0)
Tab . Pati:\tID Ertrotv m
Upgrade of Major or Minor (U)
) 4 Major |E
2. Press E to select English Word Abuse of Flagging Blanks (4
) i Eﬂedl_wc:\v\vvo;d h:tflsspe“l.hng(gvl
Mlsspelllng. IncgorrectVerbiageFEV) ¢
Failure to Flag (F)
Protocol Failure (P)
3. Press Enter to add an Error Upgrade of Minor Efor )
. . Downgrade of Major (D)
Identification marker. D ot

Grammar/Formattina (G)

Comment

4. Press Enter to jump to the
Comment area.

5. Type your comment and press
Enter to jump to the Editor panel.

Feedback anly (not graded)

Info ﬂ Ratings

)
(8105951876 _|Ryan's DemalPory ____JBones McColStoughton W]1/14/2015 _Jo:12 1715

This 1s a wrk of fiction. Names, characters, businesses, places, events and incidents are
either the products of the author’s imagination or used in a fictitious manner. Any
resemblance to actual persons. living or dead. or actual events is purely coincidental

The cursor returns to the same

CCs @ @  AddiAuth @  CommentTags = Comment =3
. | |Bones McCoy -
1 items in your pool TRAN: RRSADMIN(19798), QA: RRSQA(20970); rrs

location it was in before you added
the error.
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Notes:
— Shortcut keys are assigned by transcription company management when creating the Rating Program.

— The same shortcut key may be assigned to more than one Rating. In our example, W is the shortcut key for Medical
Word Misuse in the Critical Category and for Medical Word Misuse in the Major Category.

o Pressing W once moves to the first Rating.
o Pressing W twice moves to the second Rating.
o If Wis pressed a third time, it moves back to the first Rating.

— Comments are not required. After identifying a new error press Enter a second time to bypass the comment and return
to the transcription body.

“

— To correct the misspelling, place the cursor between “w” and “r’ of “wrk” and type “o0”.
— Return to the Demographic panel by clicking on the Info tab at the bottom. (Hotkey: Alt+1)

— Atime index is created to mark the dictation at the time the error was created. This index will be available for playback
to the person who receives your feedback.

Let QA Decide / Feedback Only

The transcription company will determine whether or not the Ratings feature will Comment
influence the Quality Score, and thus change the pay rate of its transcriptionists.

. o - e - S | A
QA staff can be given the ability to make this decision on a per-transcription P
basis. At the bottom of the Ratings window is a checkbox for “Feedback only (not
graded)” that is enabled depending on the company’s Ratings settings.
— If Ratings will not influence the Quality Score, this option is turned ON, and QA -

cannot change the setting. This option will simply provide feedback to the
person whose work you are reviewing.

|| Feedback only (not graded)

Info H Ratings

— If Ratings will influence the Quality Score, this option is turned OFF and QA
cannot change the setting.

— The company can also decide to allow the QA staff to enable this option. Doing so causes this transcription to be
ignored by the Quality Score and will not affect the transcriptionist’'s pay. By default, this checkbox is not selected when
a document is sent to QA. Select “Feedback only (not graded)” for minor changes that should not affect transcription
pay rate.

Reviewing Feedback

Wheq new feedbe.\ck is gvailablg, a link will appear at the bottom of F o Tt o ot view

In_Scnbe upon Iogln._ Click the link to open the_QA Feedback summary / ) 3 Gl Misi e
window. Feedback is also accessed via the View Menu and pressing == i B De
the button to view QA feedback. (Hotkey: Ctrl+Alt+Q) tog. WO Blshortass: [ Configure Foot Pedal | | Ra
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Navigating the Feedback List

5 QA Feedback — ]
Feedback: 2 04 < Page of 1 [+ kO
[ [~ [~] [~] - 1 [~1
. 2 safi A, ~ =
Chart 186484831 ESODemo e 2/3/2019 &, From Client o Yes
= D =k _Intouch M.D. /3 o L
o
[ [£] chart 189327708 L. ESODemo Demonstration 4/4/2019 B From Qa & Yes 100 %
User |

| % complete selected || @ complete all | | [] autocomplete unmodified feedback |

— Sort: Click on any column title to sort feedback items by that column. Click once to sort in ascending order, twice to
sort in descending order.

— Filter: Use the drop-down menu boxes under any column header to filter feedback to show only transcriptions
containing that value. Use this feature to view a particular client, document type, etc.

— Clear Filters Button %: Reset any selected filters to display any feedback items that might be hidden.
— Complete Selected: Remove feedback items by selecting the boxes on the left and clicking Complete Selected.

— Complete All: Remove all feedback items.

— Complete: Complete an individual feedback item using the “Complete” button in the M
Controls box.

— Autocomplete Unmodified Feedback: Turn on to skip feedback for transcriptions where N 0:00/19:46
the body has not been modified by QA (such as those that only go to QA to add an T. @0 ®®W =
associate). B

Records with Bold text have not been reviewed and are considered “New.” Records not in bold text have been previously
opened.

% QAFeedback = o x

Transcription Feedback T

View a specific feedback item by clicking on the 4’
transcription record. Feedback will open in the bottom UM e i T (B

< complete selected mplete il [ autocomplete unmodified feedback

of the window. The transcription text section defaults e " I——re———
to the “QA Version” Tab. ke T ey et
Appointment Date: 7/25/2019 Dictation Position: 0:00/0:43
» . . S E IR
Identified errors are placed in categories to the left. e ey _
Expand the error categories to see individual errors. P emm—— T
OUTPATIENT CONSULTATION REPORT ~
Click on the Dictation Position value in the Error Chief Complaint: [] fleave blank i not dictated DO NOT REMOVE
Details to move the playback cursor to that time on the S i
audio file. Additional playback controls allow for Play, PROCEDURE IN DETAIL: The patient comes in for the second of 3 planned
. . . treatments for metastatic carcinoid to the liver. The patient received SBRT with a
Pause, Rewind, Fast Forward, Move to Beginning, and 9 brass compensator based IMRT beams in & non-coplanar fashion. Cone beam
CT was performed before initiation of treatment and after the first 5 fields to venfy
Move to End. continued setup accuracy. The patient tolerated the treatment with no difficulty,

was discharged home, and will return next week for the final treatment. v
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When a specific error code is selected, additional error details appear which include:

— The type of error code identified.

Patient ID: 9000006 Error: Incorrect Verbiage < complete
Patient Name: Cory Jones Category: Major
- The Category Of the error COde. Appointment Date: 10/15/2002 Dictation Position: 05:30 Ly 0:00/15:46¢ |2
Transcription Comment: Erroe Conments :eelrlg World doesn't belong ORORONORO RN 8 )
— The time in the audio file that the error QaVersion | My Verson | Sere Gord |
was identified. Legend: Inserted Text Deleted Text Styled Text show changes
@ Minor This 1s a test template.
— Any additional comments about the error @ *= == Cory Jones is an 48-year old male who presented with a severe headache on 10/18/2002
added by QA. This is a sample of a multiple drop down list. Wherever the list appears, the value selected will be
entered. Iwill place the list here Option #1
If “Show Changes” is unchecked in the QA This is a sample closing
version tab, clicking on an individual error This is for Sarah.
will also highlight in blue any altered text. HISTORY: Thit i an exmple of soime text thas was removel mmm,e !
Toggle between the QA finalized version [ o

and the changes mark-up version with the
“Show Changes” checkbox.

Errors Identified TSR ‘{ QA Version H My Version | Score Card |
& Critical Legend: Inserted Text Deleted Text Styled Text [[] show changes
= Major -
Protocol Failure iction. Names, characters, businesses, places, events and incidents are either the products

of the author s imagination or used in a fictitious manner. Any resemblance TO actual people, living or dead,
or actual events is purely coincidental.

With “Show Changes” checked, the transcription is marked with QA alterations.
— Deleted items are highlighted in pink.

— Inserted items are highlighted in green.

— Items with formatting changes are highlighted in blue.

The original transcription text is available under the “My Version” tab.

The “Client Version” tab displays edits made by the client.
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Score Card

A summary of all errors and point deductions is available on the Score Card. The score card can be printed with the
available print button.

Client Version QA Version My Version J 7 Score Card \

@ print
Transcriptionist: Ryan Steffen Grading MT Initials: rrs

Transcription ID: 108527549 Date Reviewed: 3/11/2015 11:52:58 AM
; Transcription Lines: 6 Date Transcribed: 3/11/2015 11:38:44 AM
critical
Medical Word Misuse 1 (3.00) 3.00
iOmitted Dictation - (3.00) 0.00
| Patient ID Error 1 (3.00) 3.00
Upgrade of Major or Minor - (3.00) 0.00
Totals for Critical 2 6.00

Error: All Error Categories and Error Codes used by the QA Program.

Errors Recorded: The number of occurrences for the error in this transcription.

Points: The number of points deducted for each occurrence of the error.

Deduction: The number of points deducted for this error type in this transcription. This is calculated by multiplying
“Errors Recorded” by “Points.”

The Final Score for the selected transcription is located at the bottom of the Score Card. This is calculated based upon
the number of points deducted against the number of lines in the transcription.

’ DeliverHealth
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The Quick Access Toolbar

The Quick Access Toolbar is located in the top left corner of the InScribe Window above the ribbon menus. By default, it
has buttons to Save the transcription and to Stop Downloads. Toolbar options are found by right-clicking on any icon in
the Ribbon Menu or on the Quick Access Toolbar itself.

E 5| | InScribe - AA

E Home Transcription Data Format View

-+

ew Copy
Transcripti

Add to Quick Access Toolbar
Show Quick Access Toolbar below the Ribbon a

Minimize the Ribbon

— Add to Quick Access Toolbar: This option is available when right-clicking on icons in the Ribbon menu. If the item is
already present on the Toolbar, this option will be grayed out. This will add the selected action to the Toolbar.

— Remove from Quick Access Toolbar: This option is available when right-clicking on icons in the Toolbar. This will
remove the selected action from the Toolbar.

_ [=) =3 |l InScribe - AA
— Show Quick Access Toolbar above/below the
Ribbon: This option is available when right- | Remove from Quick Access Toolbar
clicking onicons in the Ribbon menu or Toolbar.
This will toggle where the Toolbar is displayed.

£

Show Quick Access Toolbar below the Ribbon

F1 T
— Minimize the Ribbon: This option is available Minimize the Ribbon :
Jump To Flay  Rewina . rasl AGU Topy wom|

when right-clicking on icons in the Ribbon menu
or Toolbar. This will hide the Ribbon Menu icons.

MNeyt Field Farward Assnciate Dictatian

Help Menu

The help menu contains troubleshooting tools and links to articles that provide information to users experiencing difficulty
or learning to use the program.

— Press the & button to open up the InScribe software page. ) )
ﬁ InScribe Website
To access the following features first press the - next to the < putton and make a . Knowledge Base
selection. -

@l About

— InScribe website: Also opens the InScribe software page. ] =] Support

— Knowledge Base: Open the DeliverHealth Knowledge base for frequently asked
questions and troubleshooting assistance.

’ DeliverHealth
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— About: Obtain statistics for InScribe and view the current transcription in HTML format. If instructed by a technician,
press the “click here” link to upload additional diagnostic data in the form of a support ticket.

— Support: Contact information to receive technical support.

Spellchecker FAQ

The suggestions that are shown in the Check Spelling dialog during spell check do not make sense. For example,
when "accepted" was misspelled, the suggestion was "crepe"?

If this occurs, try checking the “Suggest Phonetic Words” and/or “Suggest Typographical Words” options under File>
Options> Spelling.

| added a word to my User Dictionary and now it is not there. What do | do?

View Words from the Spelling and Typing Options dialog does not list the added words in alphabetical order and may give
the impression that the word is missing. If you don't want to scroll through the entire User Dictionary Word List, you can
also open the userdic.tlx file with Notepad and use the Find function to verify that a given word is in the dictionary. To do
this click on the Start button, select All Programs, select Accessories, then Notepad. With Notepad open, select the File
menu, then Open. When the Open dialog displays, go to the File Types drop-down menu and select All Files (*.*), go to
your AppData folder, then navigate to Roaming > Emdat > InScribe 6 > transcription.escription-one.com (or it may be
different if you are not logged into the US region) > Dictionary; choose the userdic.tlx file. When the user dictionary opens,
use Ctrl+F or click on the Edit menu and then Find to bring up the Find dialog and search for your word.

The suggestions for hyphenated words have an extra space. For example, when "18-year-old" is flagged by spell
check, the suggestion is "18- year- old"?

This will occur when "Split Hyphenated Words for Spelling" is unchecked in the Spelling and Typing Options dialog. Check
the box and suggestions will be provided based on each individual segment.

Spell check is not flagging misspelled words. For example, when "Zocor" was misspelled as "Zocorr", it passed
the spell check?

This will occur when "Ignore Capitalized Words" is checked in the Spelling and Typing Options dialog. Remove the check
box and incorrectly spelled capitalized words will be flagged.

Spell check is not flagging misspelled words. For example, when "cabinet" was misspelled as "cabnet", it passed
the spell check?

This will occur when "Check Word Parts" is checked in the Spelling and Typing Options dialog. Remove the check box
and spell check will look at the entire word instead of breaking it down into parts (i.e. “cab” and “net”).

| upgraded InScribe and spell check is acting differently. Words which would have flagged before are not and
words are flagging that didn't use to?

Spell check has changed and is now looking at each word in context to its surrounding words. This provides for improved
reliability and conforms more closely to spell check rules used by popular word processing programs such as Microsoft
Word.
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Removing InScribe

Note: Users on a network may need to contact their system administrators if they do not have the rights to install or
uninstall software.

Settings

— Click on “Start” and select the ‘Settings” option.
— On the Windows Setting screen select “Apps”. €03

— Scroll down to “InScribe 7.

8
=

— Click the “Uninstall” button.
b h’ype here

— Click “Uninstall” again to confirm.

Apps & features

H HEVC Video Extensions from Device Manufact... 16.0 KB

Microsoft Corporation 3/4/2020

==l InScribe 7 51.8 MB

e 3/5/2020
7.2.20007.19765

Modify Uninstall

== InScribe Training 43.2 MB

o 11/11/2019

flgﬂ’ Intel(R) Dynamic Platform and Thermal Fram... 41.8 MB

. 1n/17/2019

™ intel(R) HID Fyent Filter 229 MR
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Support

Get assistance for InScribe and all other eScription One applications here:
— Phone Support: 1-800-858-0080

— Support Email: esone.support@DeliverHealth.com

To access the eScription One software page for downloading InScribe, click here: https://www.escription-
one.com/Software/InScribe

’ DeliverHealth
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